
Overview
This software is designed to assist facilities and re-locations teams in managing staff desk allocations and
internal or external moves for a company.

The software consists of 4 main functions

Physical Desks
Staff
Move plans
Printing, Reporting and Analysis

The physical desks section allows the creation and maintenance of desk details across multiple floors and/or
sites & buildings and recording of special or varying pedestal or height configurations for each individual desk.

The staff records allow the creation and maintenance of staff details for allocation against desks. Forward
start and leaving dates are catered for, along with temporary absence for Holidays, maternatiy leave etc.
along with any specific desk heights or special chair requirements.

Once desks and staff have been set up, then the move plans modules allows creation of staff moves,
automatically verifing the new target desks for posible double occupancy, correct height, pedistal
configurations etc against existing values stored for the individual desk and staff record.

Both desk, staff, allocations and move summary reporting is provided for resource planning, budgetary or
costs anaylysis by dates, departments, sites etc.



System Requirements
Windows XP sp3 or above

Microsoft .Net Framework 3.51 sp1 or above

600 x 800 Monitor



Registering and Upgrading
To register the downloaded software for the Standard or Pro version or if upgrading from the standard to Pro
or Multi-User versions, select the register or upgrade option from the help menu and enter the registration
license key as supplied.

If you are registering a multi-user version from the free Side by Side (SBS) network shared version, please use
the Maximum Users option from the Network option on the Tools Menu.

To obtain your registration license key, please visit our websites software product pages at
http://www.asgroupservices.co.uk and select the product and version you wish to purchase from the list
available.

If a particular version you require (Multi-user, Multi-license etc.) is not displayed, please use the contact us
function on the site or email us directly at sales@asgroupservices.co.uk with details of your requirements.

When upgrading any version of the software with an updated version downloaded from our website, you may
be asked to un-install the existing software before the upgrade can be applied. This upgrade process will NOT
remove any of your existing data from your system, and your data will automatically be migrated to the latest
version, the first time the upgraded software is run.



Multi-User Side By Side (SBS) Installation and Upgrading
Installation of the Multi-user SBS version of the MOVER Database is a two part process involving the
installation of the core program and data files to a shared server location, followed by installation of client
files from this shared location to individual user PCs attached to the network.

The MOVER SBS Installer package does not by itself install the client files required to access the software,
this is performed on each user/machine attached to your network that requires access to the shared system by
running the "MoverSBSClientsetup.exe" program from the shared folder that is installed with the core server
files.

For a first time installation it is recommended that an empty network folder is setup prior to installing the
core files package that the users have read/write/delete access to.

If upgrading an existing installation then the SAME folder MUST  be used as the destination and all users
must have exited the software prior to the upgrade being installed.

It is also recommended that this installation is performed on a server or workstation capable of running the
VPAT system (i.e. .net framework 3.51 sp1 installed) and that the automatic run option is taken at the end of
the installation to finalize any post installation tasks/upgrades required.

The SBS version can co-reside with the single user version on workstations attached to the network if
required.

If the SBS server component folder is moved either logically or physically at any point then the network users
will need to uninstall the MOVER SBS client software and re-install using the "MoverSBSClientsetup.exe"
program from the new network location.

A post installation check after installation or upgrading should be made on the shared folder and any sub
folders to confirm that users access rights are sufficient to perform the various functions required.



Uninstalling Mover
The program can be uninstalled from the Control Panel Add/Remove program option

However, uninstalling the program files DOES NOT automatically remove any data that has been created when
the program has been in use.

To physically remove this data, an administrator or the user who installed the program originally will need to
manually delete the data folders.

For standalone PC installations, the data and image files are stored in a folder structure AS Services\mover

The location of which is defined by the W indows Operating system folder Common_appdata which on W indows
7 is normally C:\PROGRAM DATA, for other W indows versions (old and future) this is different or likely to be,
so users will need to check the Microsoft documentation for their specific version (XP, Vista etc….)

For Multi-user/Networks SBS versions, the data location will be in the DATA folder immediately beneath the
original program installation folder on the shared network drive.



Desks
When the application is launched it opens with the Desks Grid display.

The top of the Grid has filter options for Site & Departments in addition to custom free text filtering using the
 Filtering tool

The Grid can also be sorted by clicking on any column header, toggling ascending or descending order for each
click.

The bottom of the Grid contains the record navigator and tools for the Desks records

Use the  Add tool to add a new desk to the database or the  Edit tool to modify the existing highlighted
desks details.

Double clicking on a desk field (except Staff button) will also launch the desk editor dialog.

You can also use the New Floor option from the File Menu to add a range of desks with consecutive numbering
to the database.

Use the  Delete Tool to delete an individual desk record. You CANNOT delete a desk if it has an existing
staff allocation or is included in an open move plan.

Use the  Find Tool to locate a string in the current displayed grid.

Use the F3 function key or Edit Menu Find Next option to find the next occurence

Once desks have been added, then they are displayed in the grid as above.

Clicking on the Staff Button within the grid will cause the staff record editor to be launched to allow the
addition of new or editing of any existing staff allocation to the selected desk.

Right clicking on the staff button with an allocated staff member will launch the Move details editor for the
selected staff member and desk.



Add/Edit Desks
The following dialog is used for adding or editing individual desk records

When adding new desks select an existing site or enter a new 1 - 5 Character Site code. If a new site code is
entered then a site descriptions must also be provided.

A floor name or number (1-15 Characters) and desk number (1-10 Characters) are also required as a minimum.

The combination of site, floor and desk number must be unique.

You can flag unallocated desks as either HOT Desk OR Expansion and allocate to a department for these uses.

Raised desk heights and Pedestal Type should be entered where appropriate for Move planning use.

When editing an existing desk the Site, Floor and Desk number fields are locked to the individual desk details
being editied.

In addition, if a desk is allocated to a staff record then the hotdesk, expansion flags are unchecked by
definition and the department locked to the related staff records department.



Add Floors
The following dialog is used for adding a group of desks to the database.

When adding select an existing site or enter a new 1 - 5 Character Site code. If a new site code is entered
then a site descriptions must also be provided.

Next enter the floor to which the desks are to be allocated.

Finally create the tempate and range for the individual desks you wish to create.

The template consists of a prefix and numeric portion.

For example:

Prefix Leading Zeros Zero Padding Result

(None) 0 No 1, 2, 3 ... 10, 11, 12 ...

(None) 0 Yes 01, 02, 03 ... 10, 11, 12 ...

(None) 2 Yes 0001, 0002, 0003 ... 0010, 0011, 0012 ...

G. 1 Yes G.001, G.002, G.003 ... G.010, G.011, G.012 ...

The range of desks that will be added is displayed as options are changed.

When the range displayed matches your requirements use the Generate button to add the desks to the
database

Duplicate desks with any existing records are ignored.



Desk Picker
The following dialog is common throught the system for selecting desks for allocation to staff or move targets
etc.

When launched the dialog will display the current staff member and any existing desk allocation.

Use the Site and Desk drop downs to select the new allocation or use the Deallocate button to remove any
existing allocation.



Staff
When the Staff tab is selected the Staff grid is displayed

The top of the Grid has filter options for Staff Status, Desk Allocations & Departments in addition to custom
free text filtering using the  Filtering tool

Staff status Desk Allocations Department

Compiled from values in
database records

The Grid can also be sorted by clicking on any column header, toggling ascending or descending order for each
click.

The bottom of the Grid contains the record navigator and tools for the Staff records

Use the  Add tool to add a new staff record to the database or the  Edit tool to modify the existing
highlighted staff details.

Double clicking on a staff line will also launch the editor dialog.

Use the  Delete Tool to delete an individual staff record. You CANNOT delete a staff record if it is included
in an open move plan.

Use the  Find Tool to locate a string in the current displayed grid.

Use the F3 function key or Edit Menu Find Next option to find the next occurence

Right clicking on a staff line in the grid will launch the Moves editor for the selected staff member.



Add/Edit Staff
The following dialog is used for adding or editing individual staff records

Enter a staff name and any department information.

Enter a start date, forward start dates are automatically catered for.

If a staff member is to be away from the office for an extended period (i.e. Paternaty leave etc.) then check
the out of office flag and enter the date they will be returning.

In this state the staff members desk allocation will be retained and the printed reports, displays etc. will
report the starting/return date.

Optionally check the leaving/left flag and enter a leaving date. Forward dates are automatically catered for.

When the date passes any leaving date the staff record status and desk allocations will automatically be set
to reflect the departure.

If the staff members requires a special chair and/or raised desk check and adjust the relevant fields
accordingly.

Values in these fields are used during move planning and reporting to highlight possible furniture
reconfiguration requirements.

This dialog also allows the allocation of desks to staff members.

Pressing the ellipsis button will launch the desk picker dialog. Alternatively you can mark the staff record as
Hotdesks.

If hotdesking is checked then any existing desk allocation for the staff record is released.

If neither a desk allocation or hotdesking is selected then the staff record will have the desk status of
"Unallocated" and can be filtered in the Staff grid display

When adding a new staff record then a check is made against the existing records for a possible duplicate.

If the record your adding is definitely NOT a duplicate or you are unsure then press NO to add the new staff



record as normal

If you have entered a duplicate record then press YES and the new record will be merged with the existing
records values taking precidence



Moves
Moves records consist of 2 related parts. A Move Plan and individual Staff/Desk move details for each plan
created.

When the moves tab is selected then the move plans and move details grids are displayed.

Both Grids can also be sorted by clicking on any column header, toggling ascending or descending order for
each click.

The bottom of each Grid contains the record navigator and tools for the Moves plan and move details records

Move Plan Tool Bar

Use the  Add tool to add a new Move plan to the database or the  Edit tool to modify the existing
highlighted plan.

Use the  Delete Tool to delete a move plan and its related records

When a Move plan has been physically completed use the  Execute Move tool to process the individual move
details records and close the move plan.

Move Details Tool Bar

Use the  Add tool to add new Move details to the currently selected plan to the database or the  Edit tool
to modify the existing move details.

Use the  Delete Tool to delete the currently selected move details from the plan



Add/Edit Move Plan

Enter a description for the move plan being created or edited, a planned date for the move to be executed and
any notes for the movers, fitters etc. who will actually be carrying out the physical moves

For completed moves the fields are Readonly



Add/Edit Move Details
The common moves details dialog operation is dependent of how the dialog is launched.

When launched from the moves grid toolbar then the move plan is locked to the currently selected plan and
the staff member can be selected from the Staff dropdown.

if launched by right clicking from a staff button on the Desks grid or a staff record on the staff grid then the
Staff member will be locked and the move plan dropdown enabled to allow selection from the currently open
move plans

Use the To Desk Ellipsis to launch the target desk picker

The notes field is not editable but is compiled by automatically analysing the Source and Target desks details
and staff requirements.

The notes will included advice on any duplicate or already occupied desks, Conflicting Pedistal Types, speial
chair moves and raised desk height requirements or conflicts.



Print
When a Print request is made from the File or Reports options then the default .Net windows print dialog will
be opened

The actual dialog displayed will depend on the W indows version you are running, but the actions will be the
same

The dialog allows you to change the target printer and access the printers driver settings with the Properties
or Preference button.

However it does not allow access to change fonts or margins that are specific to the print and reporting
functions of the software itself. It is therefoe recommended that the Page Setup options available on the
main menu bars are used to assign the printer and page layout settings prior to printing.

When Print is selected the software will by default create a preview of the document from which the final print
to the selected file or device can be made.



Print and Page Setup
When opened with the Page Setup options from the File menu or dialog Setup buttons the following dialog will
appear allowing control of the Printer, page size,layout and fonts used for the Print and reports functions of
the software.

Changes to printers, page and font settings made in this and associated dialogs below are discarded if the
Cancel button is pressed on this dialog.

Pressing the "More Page Settings" button launches the default Net Page Setup dialog allowing the user to
change margins and other paper and page layout options for the selected printer.

Pressing the "Fonts" button launches the Fontset editor dialog below



When the application is started a default Font Set is created as follows:

Font Name Default Font

Title Arial 16 Point Bold
Subtitle Arial 12 Point Bold

Header Arial 10 Point Bold

Fieldnames Arial 10 Point Bold

Data Arial 10 Point Regular

Footer Arial 8 Point Bold

Note: At present the Header and Fieldnames fonts are shared in the Font Setup dialog and are displayed as a
common "Header" option.

The following shows the main font applications within the grid style reports

and Rows style report layouts



Staff By Desks
This report will preview and print the currently displayed and filtered desks grid records

It is accessed from the File Print menu when the desks grid is displayed.

A sample of the resultant report is below



Pre Move Report
This report will preview and print the currently displayed and filtered desks grid records

It is accessed from the File Print menu when the desks grid is displayed.

A sample of the resultant report is below

The report derived from the Desk and Staff records indicates existing allocations and desk configurations
including current and required raised desks, special chairs and ped types to assist with pre move planning.



Desks by Staff
This report will preview and print the currently displayed and filtered staff grid records

It is accessed from the File Print menu when the staff grid is displayed.

A sample of the resultant report is below



Post Room List
This report will preview and print all staff records on file automatically sorted in Surname order with their
department and any desk allocation.

It is accessed from the File Print menu when the staff grid is displayed.

A sample of the resultant report is below

Staff which have "left" are also reported but without any desk allocation but indicated with the "left" value
checked.



Moves
These reports will preview and print the moves summary, details and labels for the currently selected move
plan on the Moves Plan grid

It is accessed from the File Print menu when the Moves grids are displayed.

Select move plan to print both the summary and Details reports, or select each part for printing individually.

A sample of the resultant reports is below

In the above example the autogenerated notes on the details section for the move shows that the target desk
(5007) is currently identified as a raised in the desk details record but the person moving onto the desk does
not require a raised desk in their staff details record.

It also shows that the source and target desks have different Ped types.

When labels is selected then the following dialog is displayed.



Select the label format your require and the optional Ped move information. Print will output a page of labels
for each move in the plan, including name, from desk and to desk information and optional line "Ped Move Yes
or No"

When the moves grid is displayed you can also use the tool menu "Export Labels" option to create a Comma
Seperated Format (CSV) file containing the same information for use with a word processor label merge or
other compatible appllications to create custom labels.



Reports & Analysis

The Reports menu provides access to support and ancillary reporting summaries to assist with moves and
staff and desking management.

The Raised Desks exception report lists any current or new staff that have a raised desk requirement, but are
not allocated a raised desk or vica verca

The Desk configurations report lists desks records by Site, floor, desk number along with details of raised
heights, ped types and notes

The Desks allocation reports list current desk allocations by site and/or department.

The moves analysis report allows production of completed move analysis, by date, month, department and
sites etc. useful for both costing and future resource planning for moves.



Network Tools
The network tools module is available in the SBS Multi-user version of the software and can only be run by
local administrators or if the software is launched under administrator user profile.

The module will display the current user, application location and details of the maxiimum licensed concurrent
users and users currently recognised by the software.

Any users that are currently accessing the database are indicated by the logged in checkbox.

Use the Maximum Users button to register the multi-user version or register a user pack upgrade.

Using the refresh button will update the current state of the users list.

Hi-lighting a user and using the logout button causes a closedown application message to be sent to the
remote users desktop as below.



Filtering Records
When a filter string is available for record display or in reporting options such as using the  filter tool on the
Desks grid tab as below....

....then multiple filters can be set if required using the | (Vertical Bar) character between the words or phases
you wish to filter

For Example:

Entering the string SMITH in the above would restrict the displayed records list to only those records that
contain the characters SMITH in any fields

Entering the string SMITH | JOHN into the filter field and setting the radio button to Match Any (default)
results in only records containing the characters  SMITH OR  JOHN in the displayed fields

such as "Ian Smith, Johnny Smith and John Jones"

Setting the Radio Button to Match All results in records containing the Charcters  SMITH AND  JOHN in the
displayed fields

Resulting in only "Johnny Smith" being displayed from the above example


